/f"\ LAKEDALE

COMMUNICATIONS

Dial-up Internet & E-mail Setup Instructions
for

Windows 95 and 98

If, after you have read this document, you are still having difficulties with the installation, please contact
Lakedale’s Internet Help Desk at:

320-274-9800 Annandale, Maple Lake, and South Haven
320-243-9800 Paynesville

763-675-9800 Buffalo, Montrose, Rockford, Twin Cities, and Waverly
877-535-3375 Toll-Free

Technical Support 24 /7

Make New Connection

> ] »

Dial-Up b ake Mew
Metworking Connection

Tvpe a name for the computer vou are dialing:

ty Computer | Lakedsle

Select a modem:
5252 [ (Your Modem's Name Here) =]
LConfigure... |

Double-click on My Computer.
Double-click on Dial-Up Networking.
Double-click on Make New Connection.

The Make New Connection window appears.
The default name is My Connection.

Type in a new name: Lakedale.

¢ Hack I Mext > I Cancel |

Click Next >.

At the Phone Number Window type in the Make New Connection
phone number to call the modem pool.
See the chart below.

Type the phone number for the computer vou want to call

Lrea code; Telephone number;
Click Next >. |
Country code;
Lakedale Modem Pool Phone Numbers |United States of America (1] =]

274-9500  Annandale, South Haven
963-9500  Maple Lake
243-9500  Paynesville

675-9500  Buffalo, Montrose, Twin Cities, &
Waverly

286-6622  (Cokato, Dassel, & Howard Lake

¢ Back I Mest > I Cancel |

Make sure you choose a number that is a local call for you. If you choose one that is long distance,
you will be billed for the long distance calls.
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Dial-up Internet & E-mail Setup Instructions for Windows 95 and 98

Make Hew Connection

Click Finish to create the connection
icon shown below.

Lakedale

Put your mouse pointer over the icon
above, and click the mouse’s right button
once. A menu box will open. Click once
with the mouse’s left button on
Properties to open up the properties for
this connection.

ou have succezsfully created a new DialHdp Metworking
connection called:

Click Finizh to zave it in your Dialld p Hetworking folder.
Double-click it to connect.

To edit thiz connection later, click it, click the File menu
and then click Properties.

< Back I Finizh I Cancel

Make sure that the telephone number you are
calling is correct. Also, make sure that your
modem is selected in the Connect using
window.

Next, click on the tab Server Types at the top
of the window.

2]
General |Sewer T_I.Jpes' Scriptingl Multilink'

e
)

— Phone rumber:
Area code: T elephone number:

| =l

Country code:
IUnited States of America [1] j

[ Use area code and Dialing Properties

— Connect using:

s | U 5 Robotics 56K Win INT =
LCanfigure. . |

(] I Cancel |
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Make sure that the Type of Dial-Up Server starts I

with PPP. .
General  MNetworking |Scripling| Multiink |

Under Advanced options, the only box that should
be checked is Enable software compression.

Type of Dial-Up Server:

IF'F'F': Intemet, Windows MT Server, Windows 38 LI

Under Allowed network protocols, the only box
that should be checked is TCP/IP.

—Advanced options:

i

=

Click on OK when finished ¥ Enable software compression
[ Require enciypted password

™ Requirs data encryption

[ Becord a log file for this connection

— Allowed network. protocols:
[~ MetBELI
[ IPX/5P Compatible

¥ TCPAP TCE/IP Settings... |
(1] 4 I Cancel |

B |
Make sure the following settings are checked: TCP/IP Settings EAE3 |

% Server assigned |P address

e Server assigned IP address % _
e Server assigned name server addresses, dpesdan (B addiess
e Use IP header compression R | B oarn g |
e Use default gateway or remote network
Click OK. 8 Server aszighed name server addresses
{1 Specify name server addiesses
Click OK again when finished. Prirnary DNS: | . Do o |

Secandary DNS: | 0o .0.0 .0 |

Frirnany Wi hs: | o,o0 ., 0,0 |

Secondary WINS: | o, o0 .00 |

W Uze|P header compression

W Usze default gateway on remote nefwork -

Cancel |
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HE|

Now, double click with the left mouse ¢ Connect To
button on the icon Lakedale in the
Dial-up Networking window. Make =] .

P & S =18 Lakedale
sure the number you are calling is =
correct.

Uzer name: I uzernamei@akedalelink net

Make sure you are not dialing long
distance. If you are in the 320 area code, EReianst I
make sure that 320 is not being dialed. I Save password
If the phone number is not correct, click
on Dial Properties. Phone pumber: I

[haling from: I

If the area code is wrong, delete it and then type
the correct area code. If you need to turn off/on

10-digit dialing, click on Area Code Rules and
check always dial area code (10-digit dialing).
Do not do this if you have 320 area code.

If you have Call Waiting and need to disable this
feature, check the box To disable call waiting,
dial:” Then in the pull down, click on *70.
There may be additional charges to use Call
Waiting. If you are not sure if you can use *70,
call our Customer Service Center.

If you are dialing long distance and your area
code is correct above, make sure the box Dial as

a long distance call is not checked.

Click OK when finished.

Connect | Cancel
Dialing Properties K
My Locations |
| am dialing fram;
|HDI'HE j MHew... | HEfmuve |
| arm in this country/region: Area code:

ILInitecI States of America j i32D

Area Code Rules... I

=When dialing from here

To access an outzide line:
For local callz, dial

Dial uging: & Tane dial

[ To dizable call waiting, dial

—

For lang distance callz, dial I

o

i~ Pulse dial

[ For long distance calls, use this caling card:

Ih'c-: & | Direct Dial)

| CalingCard... |

MHumber o be dialed:  274-9500

[ Dial as a long distance call

Cahcel

Apphy
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Next, you will make sure that your computer’s Network protocols are set up correctly.

First, click on the Start button on your desktop,
then go to Settings and click once on Control
Panel.

) o
When the Control Panel opens, =]
click twice on the icon Network. M etk

WARNING: If you are on a network (more than
one computer connected together) do not remove
items from this box. Contact your system
administrator before completing installation.

When the window opens, if it looks exactly like the
one to the right, click cancel, and go to page 9 to
set up your e-mail.

If it does not, then your Network protocols will
need to be set up.

If you have more items than what is indicated here,
click on each of them individually, then click once
on the Remove button. Keep doing this until they
are all gone.

When all the components are removed, click once
on the Add button.

Choose Client and click on Add.

Metwork

Caonfiguration | Identification I Access Control I

The following network, components are installed:

Chent far Microzoft Metwarks
Dial-Up Adapter
TCR/AP

Hermove |

Eroperties |

Frimary Metwork Logon:

IEIient for Microzoft Metworks

File and Frint Sharing... |

Dezcription

Ok

Cancel

Select Hetwork Component Type

B Adapter
[ Protocol
Service

Click the twpe of network component pou want ta install:

A client enables your computer to connect ta other
computers.

Caticel

1=
[w
| =N
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Click on Microsoft under Manufacturers and click  EEEELTEETANENG [x]

on Client for Microsoft Networks under Network
Clients. =

Click the Metwork Client that pou want to install, then click OK. If you have
an installation disk for this device, click Have Disk.

Manufacturers: Mebwork Clients:

Client far Mefw/are Networks
Microzoft Family Logon

Click OK when you are done.

Hawe Dizk. .. |

Ok I Cancel |
Metwork
If you have Windows 98, your Network window Configuration | dentfication | #ecess Cantrol |
should look like the one to the right. (If it looks _ .
almost identical, but there are two TCP/IPs, click The ED_"DW'”Q ﬂ_EtWD'k compenents are installed
once on the top TCP/IP and click once on the Client for Microsoft Networks
Remove button.) DiakUp Adapter
= : TCRAP
If you have Windows 95 go to the next page.
If your Network looks the same, click the OK HEmeye | Propsities |
button at the bottom of the window. You are done. . _
: rimary Metwork Logon:
Your computer will copy files from your hard [l fox Micrasalt Netmorks |
drive. It may even ask for your Windows 98
System Software CD. Follow the Instructions in the File and Frint Sharing... |
pop-up windows. When you are prompted to restart Desciption
your computer, do so.
Continue on to page 8.
Ok Cancel

Page 6 of 10




Dial-up Internet & E-mail Setup Instructions for Windows 95 and 98

If you have Windows 95, you will need to
continue with the Network Protocol Installation.
On the Network window, you should see the
following installed Network Components:
oClient for Microsoft Networks
eDial-Up Adapter
o[PX/SPX
oNetBEUI

If you see these components, click on the Add
button to install the TCP/IP.

Select Network Component Type

Click. the twpe of netwark. companent you want to install:
Client

Add...

Cancel |

% Protocol

Protocol iz a 'language’ a computer usez. Computers
must use the same protocal to communicate,

When the Select Network Component Type window opens, choose Protocol and click once on the Add

button.

When the Select Network Protocol window
opens, click once on Microsoft under
Manufacturers, and click once on TCP/IP under
Network Protocols. (Note: You may need to use
the scroll bar to scroll down to where TCP/IP is
located. It is at the end of the list.)

Click OK.

You will return to the Network window under the
Configuration tab. You will see the window to the
right.

Now, click once on IPX/SPX and click once on the
Remove button. Do the same thing to NetBEUI.

You should now have only the following in the
window: Client for Microsoft Networks,
Dial-Up Adapter, and TCP/IP.

If this is what you have, click on the OK button at
the bottom of the window.

Your computer will copy files from your hard
drive. It may even ask for your Windows 95
System Software CD. Follow the Instructions in the
pop-up windows. When you are prompted to restart
your computer, do so.

Select Metwork Protocol E3

Click the Metwork Protocal that you want to install, then click QK. If you have
3 an inztallation disk. for this device, click Have Disk.

Manufacturers:

Metwark, Protocols:

4 Fast Infrared Protocol =]
4 IPX/5Px-compatible Pratocol

4 Microgoft 32-bit DLC

& Microgaft DLC

Hawve Disk. .. |
oK. I

Cancel |

Hetwork

Configuration I Identificatiunl Access Euntrull

The following network. components are installed:

Client for Microzoft Metworks
Mal-Up Adapter
IF= /5P -compatible Protocol
MetBELI
TCPAR

EEmaye | Broperties |

Frimary Metwork Logon:
Client for Microsoft Metworks j

File and Print Sharing... |

Description

QK Cancel
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When your computer restarts, double
click on the Internet, or Internet

Internet Properties

7%

Generali Securityl Content  Connections |F'rngrams| .&dvancedl

&

Options Icon on the Control Panel.

Click on Connections, it’s a tab at Internet QT_!_} Use the Internet Connection /izard to
I:'FITiIIIr'IS =1 connect your computer to the Internet.

the top of the window.

— Dial-up settings

Lakedsle (Default) Add..

This will open a window called Internet
Properties. It most likely will look like the
window to the right. If it looks different, make
sure that dial-up connection is selected to use
your phone line or modem. Make sure your Dial-
up Networking Connection is Lakedale.

Bemaove

i

Settings....

™ Mever dial a connection
¢~ Dial whenever a network, connection is not present

& Salways dial mp default connection

Current default; Lakedals Setieratlt

If you have the window to the right make sure
that it says Lakedale (Default) under Dial-up
settings. If it does not, click once on Lakedale to
highlight it and then click on the button that says
Set Default.

v Perform system security check before dialing

— Local Area Network, [LAM] settings

L&aM Settings... I

Next, make sure that the radio button Always dial ok |

. . Apply |
my default connection is selected.

Cancel |

Click on Settings.

Lakedale Settings

—Automatic configuration

Automatic configuration may overide manual zettingz. To ensure the
uze of manual settings, dizable automatic configuration.

In the Lakedale Settings window, type in your
User name and Password that you supplied to
us on your Dial-up Internet Application. (Note:
the password will appear as asterisks. It is
encrypted for your protection.)

[ Automatically detect settings

I Usze automatic canfiguration script

Tl
SOdiEss |

— Promy zerver

Click OK and close the Control Panels. -

tddiess | ot |

I | Bipaes proqy semvenfonloeal addresses

You are done.

i~ Dial-up settings

Uszer name; Iusername@lakedalelink.net Froperties I
Pazzword: | Advanced I
Damair: |
[~ Donot allow Internet programes to use this connection
0K I Cancel

You can now open programs such as Internet Explorer & Netscape Communicator to surf the Internet.
You can also set up e-mail programs such as Outlook Express and Netscape Messenger to use your
Lakedale e-mail account. To start the programs, double click their icons on your desktop or click on start,
go to programs and click on Internet Explorer, Netscape, or Outlook Express.
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E-mail Setup Instructions

Outlook Express — To add an E-mail Account:

If you are using Outlook Express for the first time, you may get a connection wizard when you open the
program. Follow the instruction in the wizard. Note: at the beginning of the wizard, it may ask you if you
want to open a new account or use an existing account. You want to use an existing account. Fill in the
questions in each window with the information provided by Lakedale and click Next. When the
installation is complete, click Finish.

1.

2
3.
4

9]

10.

11.

12.

13.
14.
15.

Open Outlook Express. On the Tools menu, click Accounts.
Click on the mail tab.
In the Internet Accounts dialog box, click on Add button.

Select Mail to open the Internet Connection Wizard, and then follow the instructions to
establish a connection with a mail server.

Display Name: (Your Real Name e.g., John Smith). Click, Next.

Choose I already have an e-mail address I’d like to use. Type in your e-mail address provided
by Lakedale (e.g., example@lakedalelink.net). Click, Next.

The incoming mail server type is a POP3 server. The incoming mail (POP3) is:
pop3.lakedalelink.net (in small, lowercase letters). The outgoing mail (SMTP) is:
smtp.lakedalelink.net (in small, lowercase letters). Click Next.

Type in your Account Name. It’s your e-mail address (e.g., example@lakedalelink.net). Put
in your password. If you type in your password here and select Remember Password, you
won’t have to enter it each time you try to check your mail. Click Next. Click Finished.

After you click finished, you will return to the Internet Accounts dialogue box. Make sure
your new account is highlighted. On the right side of the box, select the Properties button.

Click on the Servers tab. Put a check mark in the ox to the left of My server requires
authentication. Click Settings.

Select Log on using. In the Account name field, type in the first part of your e-mail address
hyphen lakedalelink (e.g., example-lakedalelink).

In the Password name field, type in your password and put a check mark in the box to the left
of Remember password. Click OK.

Click on the Advanced tab. In the Qutgoing mail (SMTP) field, type in 587. Click OK.
You are now finished. Click Close.

To learn how to use your e-mail program, click on Help on the tool bar at the top of the
Outlook Express window. Click on Contents and Index. In this help window, you may read on
how to use all of the functions of Outlook Express mail.
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E-mail Setup Instructions (continued)

Netscape Messenger E-mail — Using the Mail Setup Program:

If you have just installed Messenger or have yet to set your preferences for sending and receiving mail,
you will be prompted to use the Mail & Newsgroups setup program (Windows and Mac OS (only) when
you first open your Inbox. Note: Lakedale no longer offers Newsgroups.

The setup program asks you to provide settings for required preferences. If you do not know a setting, you
must exit the program and consult Lakedale’s Help Desk. You can always change these settings later by
choosing Preferences from the Edit menu and selecting the Mail & Newsgroup Preferences category.

To use the Mail Setup Program:
1. Be sure to type the following information exactly as it’s given to you. Match uppercase and

lowercase characters. Click Forward or Back to move through the panels. To cancel your
changes click the window’s close box.

. Your username on the mail server. Same as your E-mail Address.
. Your password for the mail server. Same as your Account Password.
. Your reply-to or return address. Your return address is usually your username

combined with your site and domain names (e.g., helpdesk@lakedalelink.net).

o Your real name: Netscape Messenger includes it with your username when you send
a message. (Hint: Put your name here how you would write it on any application,
e.g., John Smith.)

. The incoming mail server is a POP3 server. The incoming mail (POP3) is:
pop3.lakedalelink.net (in small, lowercase letters).

. The outgoing mail (SMTP) is: smtp.lakedalelink.net (in small, lowercase letters).

2. Click OK.

You are finished. To learn how to use your e-mail program, click on Help on the tool bar at the top of the
Netscape window. Click on Help Contents. In this Help window you may read on how to use all of the
functions of Netscape Messenger.
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